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Introduction 

Congratulations on the purchase of the Xtension Recorder and the associated Administration Software, Reporter Proer. 
The purpose of this document is to describe the features and functions of the core software separate documents will 
provide Reporting, Scoring and Call Archiving instructions .  

This user guide will take you through the installation and setup of the XTR Reporter Pro and help you begin using the 
advanced search and playback features provided. 

Important Notes: 

For support and product information and manuals please go to our website www.usbcallrecord.com . 

Caution!  The use of monitoring, recording or listening devices to eavesdrop, monitor, retrieve or record telephone 
conversations or other sound activities, whether or not contemporaneous with transmission, may be illegal in certain 
circumstances under federal or state laws.  Legal advice should be sought prior to implementing any practice that 
monitors or records any telephone conversation. 

PC Compatibility:  The XTR Administration software supplied will work on recent Microsoft operating systems including 
2000, XP and Windows Vista 32 bit systems. Note: Windows 95, 98 NT and Macintosh are not supported. 

Contents 

Check the package contents: 

- 1 x XTR Reporter Pro CD 
- 1 x XTR Dongle Protection Device 
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Installation Process 

Insert the CD provided into your PC CD/DVD drive and follow the instructions: 

The Box on the left will appear,  

Select YES to agree to licensing agreement                  

 

 

 

 

 

 

 

 

        Using the Browse button, select                                           This dialog shows the installation progress 
        path you wish to install the  
        software, we suggest you use 
        the default location provided. 

 

 

By selecting Finish the software program will be completely installed. 
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Software Protection Devices 

 XTR Administration software is provided with a software protection device that must be installed in a USB Port in the 
computer you are using.  
 
Important Note:   XTR Reporter Pro will not operate without the USB key installed.  
 
There are two versions of USB dongle supplied.  It is most likely that you will have the Secure DongleX device with your   
XTR Software, however, if you are upgrading from an older version of   XTR software, you may already have the 
MatrixLock USB Device and may be required to exchange for a new device.   

SecureDongle X USB driver installation  

The SecureDongle X uses a driver included in the Windows operating system. When the 
SecureDongle X is inserted into the USB port, the operating system will prompt you to install a 
new device, which will then install automatically.  You will then be able to use the XTR 
Software. 
 

MatrixLock USB        

If upgrading from an older version of XTR Software, please contact your reseller in order to 
obtain the new USB keys. 
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Starting XTR Administration Software  

 

  XTR Reporter Pro can be started by locating the   XTR Reporter Pro Desktop Icon and double clicking or by choosing 
the   XTR Reporter Pro option in your Windows Start Menu(s). 

 

  XTR Reporter Pro will now start – please ensure the dongle protection device is installed before starting.  

Main Window Interface 

The Main window is the   XTR Reporter Pro application window which appears when the application starts 
 

Main Menu 

• The Main Menu provides 
access to the primary 
application controls.  

• It is located at the top of 
the Main Window under 
the window caption.  

Access Panel 

• The Access Panel is a 
dynamic panel group of 
physical and virtual trees 
which provides access to 
recordings.  

• The group is comprised of:  
o My Explorer Panel  
o My Shortcuts Panel  
o My Calls for Review 
Panel 

Recordings List 

• Recordings Lists form the core of   XTR Reporter Pro.  
• Recordings Lists provide an interface to interact with recorded calls for tasks like viewing, search & data-

mining, editing, playing, emailing, and managing calls.  
• Recordings Lists are document windows which appear in the centre of the Main Window.  

Player Panel 

• The Player panel is a dynamic container which houses the Player.  
• All   XTR Reporter Pro playback and audio controls are handled by the player.  
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Access Panel Interface and Features 

The Access Panel provides access to recordings. The group is comprised of the My Explorer Panel, My Shortcuts Panel, and My Calls for Review panel.  

Explorer Panel Features & Functions 

• The Explorer Panel is a physical tree of resources, drives and directories accessible from your computer 
much like Windows Explorer.  

• The Explorer functions can be accessed from the Explorer Tree toolbar and right-click menu.  
• The Explorer Tree can be used to create Recordings Lists, Shortcuts, append calls to Recordings Lists and 

copy calls from Recordings Lists.  

Explorer Panel Functions 
Function Description 
Create Recording List Open the Create Recordings List Window to build a Recordings List from 

the selected folder. 
Add to Shortcuts Create a Shortcut from the selected folder which appears in the 

Shortcuts Tree root group.
Explore Open Windows Explorer focused on the selected folder to display and 

access the contents of that folder. 

Copy Recordings Drag n Drop selected recordings into explorer window to Copy 
Recordings into desired folder. 

 

Shortcuts Panel Features & Functions 

• The Shortcuts Panel is a virtual tree which can be used to create Shortcuts for quick access to call 
sources.  

• The Shortcuts functions can be accessed from the Shortcuts Tree toolbar and right-click menu.  
• A Shortcut can be used to create a Recordings List from the call source it references, bypassing the 

need for navigation.  
• Shortcuts can be organized into folders called Shortcut Groups which provide a method to create 

a single Recordings List for all shortcuts contained in the Shortcut Group.  
• Any number of Shortcuts and Shortcut Groups can be created and named as required.  
• Shortcuts and Shortcut Groups can be organized into subgroups.  
• Shortcuts and Shortcut Groups are virtual indexes.  
• Moving, renaming or deleting Shortcuts has no impact on the actual recorded files.  

 

 

 

Shortcuts Panel Functions 

Function Description 
Create Recording List Open the Create Recordings List Window to build a Recordings List 

from the selected Shortcut or Shortcut Group. 
Explore Open Windows Explorer focused on the selected folder. 
Select All Select all Shortcuts in a Shortcut Group 
New Group Create a new Shortcut Group. 
New Shortcut Open a folder dialog to select the resource to Shortcut. 
Rename Enable renaming of the selected Shortcut or Shortcut Group 
Clear Shortcuts Remove all Shortcuts in a Shortcuts Group. 
Remove Delete the selected Shortcut or Shortcut Group. 

Note: As Shortcuts and Shortcut Groups are virtual indexes, moving, renaming or deleting 
them has no impact on the actual recorded files. 
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Calls for Review Panel Features & Functions 

• The Calls for Review Panel is an organizational tool that can be used to hold links to recordings for later review.  
• A  Review Folder works in the same manner as Favorites or Bookmarks in your browser by storing and 

organizing links to play recordings.  
• The Review functions can be accessed from the Calls for Review toolbar and right-click menu.  
• You can create any number of folders in this area, name them as required and organize them into groups 

and subgroups.  
• Recordings can easily be added to a Calls for Review folder using drag and drop from a Recordings List or 

using the Calls for Review Control in the Recordings List or Player Toolbar.  
• Recordings can easily be removed from a folder using select or multi-select and Delete from the Toolbar, 

right-click menu or delete key.  
• Removing or deleting the Calls for Review folder or the linked recordings has no impact on the recorded files.  

 

 

Calls for Review Panel Functions 

Function Description 
Play Load the selected recording into the Player and starts playback. 
Select All Select all recordings within a Hotlist.  
Copy Copy references to the selected recordings to the clipboard. 
Paste Append the selected recordings to the Recordings List. 

Remove Delete the selected Hotlist. Note: As Shortcuts and Shortcut Groups are virtual indexes, 
moving, renaming or deleting them has no impact on the actual recorded files. 

New Hotlist Create a new Hotlist. 
Rename Hotlist Enable renaming of the selected Hotlist. 
Clear Hotlist Delete all linked recordings within the selected Hotlist. 
Remove Duplicates Remove duplicate linked recordings a Hotlist. 

Explore Open Windows Explorer focused on the parent folder of the selected 
recording. 
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Recordings List Features 

Recordings Lists form the core of   XTR Reporter Pro.  

• They provide an interface to interact with 
recorded calls for tasks such as viewing, search 
& data-mining, editing, playing, emailing and 
managing.  

• Recordings Lists are document windows which 
appear in the center of the Main Window.  

• Detailed information about each recording is 
displayed in a tabular view with a reference to 
edit, playback and manage the recorded call.  

• You can work with and toggle multiple 
Recording Lists simultaneously and customize 
by adding or removing calls.  

• Recording Lists can also be saved and shared 
which provides a worksheet for analysis.  

 

Function Description 
Header The Recordings List Header appears at the top of the Recordings List. 

In the Header, an icon and name label identifies the source of the recordings displayed in the Recordings List. 
For example – If the Recordings List Header displays ‘My Calls’, the Recordings List was compiled using a 
Shortcut called ‘My Calls’. 
The Recordings List compilation date and time appears to the far right in the header. 

Toolbar The Recordings List Toolbar provides various controls to work with recordings and recording information. 
Data Fields Column Header Data Field Column Headers display the name and data field, can be used to sort the data in ascending or 

descending order. 
Selected Recording and 
Data Fields 

Data fields display captured and user defined recording information like User ID, Caller ID and Comments etc. 
Each recording appears on a row with recording information organized into data fields. 

In-Place Editing The Caller ID can be edited in place by selecting the field and clicking. 
Summary Bar The Summary Bar appears at the bottom of the Recordings List it provides summary statistical information 

about the recordings in the Recordings List. 
Information like the number of recordings, number of recordings marked as important and total duration of 
Recording List. 

Context Menu The Recordings List Context Menu provides a shortcut to common controls associated with Recordings Lists 
and is available by right-click inside the Recordings List. 

Multi-Select Recordings Lists support several functions which can be performed on multiple recordings simultaneously using 
multi-select. 
You can also use default windows keyboard functions like CTRL+A and SHIFT+ARROW KEYS. 
You can also use keyboard and mouse combinations like CTRL+MOUSE-CLICK and SHIFT+MOUSE-CLICK. 

Drag and Drop Recordings List drag and drop functions can be used to customize Recordings Lists. 
They can also be used to link or copy recordings from Recordings Lists. 
Drag and Drop is also available directly from Windows Explorer. 

Window Controls The Recordings Lists Windows can be minimized, maximized, restored and resized. 
The Windows Menu provides options to Cascade and Tile multiple Recordings Lists. 
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Create Recordings List Window Features & Functions  

• The Create Recordings List Window appears when you attempt to create a Recordings List 
which requires the source to be scanned for recorded files.  

• Call sources which are scanned are those from the Explorer Tree, a Shortcut or Shortcut 
Group.  

• The Create Recordings List Window provides query options on the calls archive which can be 
used to compile a more targeted Recordings List.  

• Query options are defaulted to retrieve all calls from last 30 days so you can simply click 
Compile or press Enter when the Create Recordings List Window appears.  

• Query options are described in the Functions section.  

 

 

Create Recordings List Window Functions 
Function Description 
Paths List/Name list This displays the path and resource to scan for recordings. 
Include sub-directories This option can be used to include or exclude scanning sub-directories for recordings. 
Add This option can be used to add additional recordings sources to include in the scan. 
Remove This option will remove the selected source. 
All Dates This option will ignore the recording created date filter. 
Yesterday and Today This option will apply a date filter which will retrieve only recordings created on the current date or one day 

prior. 
Within 7 days This option will apply a date filter which will retrieve only recordings created within 7 days of the current date. 
Within 30 days This option will apply a date filter which will retrieve only recordings created within 30 days of the current 

date. 
After this Date This option can be used to define the start of the date range ignoring recordings created prior to this date. 
Before this Date This option can be used to define the end of the date range ignoring recordings created after this date. 
All Calls This option will ignore the recording file length filter. 
 This option can be used to define the minimum file length which will retrieve only recordings larger the 

specified length. 
Compile Begins Recordings List compilation for the defined attributed. 
Cancel Aborts Recordings List compilation. 

Recordings List Toolbar Functions 
Function Description 

Play 
Start playback of the selected recording. Or Create a new Recordings List 
of the selected recordings and start playback when calls are multi-
selected 

Refresh Update recording information for all recordings in the Recordings List. 

Search Launches the search Window to drilling down the Recording list by User ID, 
Caller ID, Comment or All via keyword. 

Email Original Format Launch default email application send email form and attach selected 
recordings in XTR format. 

Email WAV Format Launch default email application send email form and attach selected 
recordings in WAV format. 

Convert to WAV Launch the Convert Recordings Window to convert the file. 

Convert to Original Launch the Convert Recordings Window to select the format and convert 
the file. 

Delete Permanently delete the selected recordings. 
Notes Add annotation notes to the selected call. 
Mark Important Flag the selected recordings as Important. 
Un-mark Important Remove the Important Flag from the selected recordings. 
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Recordings List Right-Click Menu Functions 

Function Description 
Play Load the selected recording into the Player and start playback. 
Copy Copy references of the selected recordings. 
Paste Paste recording references from the clipboard. 
Remove Remove the selected recordings. 
Trim Remove the non-selected recordings. 
Select All Select all recordings. 
Mark as Important Flag the selected recordings as Important. 
Un-mark Important Remove the Important Flag from the selected recordings. 
Delete Recording Permanently delete the selected recordings. 

Recordings List Data Fields Features 

Function Description 

Exclamation Icon If a recording displays an Exclamation Icon, the recording is flagged as 
Important. 

Blank If a recording does not display an Exclamation Icon, the recording is not 
flagged as Important. 

User ID The User ID field displays the ID of the person who created the recording. 

Caller ID The Caller ID field displays the number dialled, the inbound number 
captured or user defined information. 

Date & Time The Date & Time field displays the date and time the recording was created. 

Duration The Length field displays the length of the recording in hours, minutes and 
seconds (hh:mm:ss). 

Bookmark If a recording has a bookmark associated with then an Bookmark icon is 
displayed 

Comment The Comment field displays any user entered notes. 

Recordings List Sorting and Filtering Functions 
Function Description 

Important Click the header to sort ascending or descending as indicated by the 
small arrow to the right of the header. 

User ID Click the header to sort ascending or descending as indicated by the 
small arrow to the right of the header. 

Caller ID Click the header to sort ascending or descending as indicated by the 
small arrow to the right of the header. 

Date & 
Time 

Click the header to sort ascending or descending as indicated by the 
small arrow to the right of the header. 

Length Click the header to sort ascending or descending as indicated by the 
small arrow to the right of the header. 

Bookmark Click the header to sort ascending or descending as indicated by the 
small arrow to the right of the header. 

Comment Click the header to sort ascending or descending as indicated by the 
small arrow to the right of the header. 
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Player Features 

• The Player panel is a dynamic container which houses the Player.  
• All   XTR Reporter Pro Playback and audio controls are handled by the player.  

 

 

Player Features 
Function Description 
Header When a recording is loaded into the Player, the file name appears to the far left. 

By default, the Player is docked and locked at the bottom of the Main Window. 
The Player Panel can also be undocked from its position to float freely about the screen using mouse drag or 
double-click in the Header.  
The Player can be re-docked to its position by drag & drop to is docking position or double-click in the 
header.  
The Player can be resized vertically with mouse drag from the top of the header. 

Toolbar The Player Toolbar provides access to file, and data in the Player. 
Recording Information 
Fields Recording information appears in columns at the top of the display area. 

File Information Icons 
The Important icon – If this call is mark as important the important will be displayed 
The Bookmark icon – If the call has a bookmark associated then the bookmark icon will be displayed. 
The Notes icon – If the call has any notes added then the notes icon will be displayed. 

Playback Timer / 
Recording Length 

The playback timer appears to the middle and displays the current playback position in the recording over 
the total length of the recording (hh:mm:ss / hh:mm:ss).  
The playback position in the recording is determined by the position of the Track bar.  
Recording length information displays the duration of the recording. 
 

Basic Controls These are the playback Play, Pause, Resume and Stop functions. 

Player Toolbar Functions 

Player Toolbar Functions 
Function Description 
Mark Important Flag the call as Important. 
Unmark Important Remove the Important Flag. 
Email Original Format Email the call as an attachment in the original file format. 
Email WAV Format Email the call as an attachment in WAV format. 
Convert to WAV Format  Launch the Convert Recordings window to convert the call to WAV 
Delete Permanently delete the call. 
Eject Eject the call and release file locks so others call access the call. 
Calls for Review Display the Calls for Review Tree control to add the recording to a folder. 
History Display the current play History. 
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XTR Reporter Pro Utility Features 

This section provides information about the following utility features of the application: 

• Using Drag and Drop throughout the Application 
• Using Keyboard Shortcuts 

Drag & Drop Functions 

Control Actions Result 
Recordings List Selected calls from a Recordings List into 

another Recordings List. 
Copy the references of the selected recordings into Recordings List 
(excludes duplicates). 

Windows Explorer Selected calls from a Windows Explorer 
source into a Recordings List 

Append selected recordings from Windows Explorer to the Recordings 
List. 

Windows Explorer A call from a Windows Explorer source 
into the Player. 

Loads the selected recording into the Player (multiple calls not 
supported). 

Keyboard Shortcuts 

Control Actions Result 
Main Window  CTRL + O Launch a file dialog window to open a saved Recordings List. 
Main Window  CTRL + N Create a new blank Recordings List. 
Main Window  CTRL + S Launch a Save dialog window to save the Recordings List. 
Recordings List CTRL + C Copy references of selected recordings in the Recordings List to the clipboard. 
Recordings List CTRL + V Paste references to recordings from the clipboard into the Recordings List. 
Recordings List CTRL + P Load the selected recording into the Player and start playback. 
Recordings List CTRL + A Select all recordings in the Recordings List. 

Recordings List DELETE Remove the selected recording from the Recordings List (the actual recording file is not 
deleted). 

Player CTRL + SPACEBAR Pause and resume playback. 
Shortcuts DELETE Deletes the selected Shortcut or Shortcut Group. 
Calls for Review DELETE Deletes the selected  link to recording (the actual recording file is not deleted). 
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Using   XTR Reporter Pro  
Step 1 – Create Your Shortcuts 

How to Create a Shortcut from the Shortcuts Panel 

1. From the Shortcuts toolbar or right-click menu, click the New Shortcut option.  
2. The Create Shortcut Window will appear.  
3. Click the browse button and navigate and select the calls source to Shortcut.  
4. Click OK to confirm and OK again to create the Shortcut or Cancel to 

abort.  

How to Create Shortcuts from the Explorer Panel 

1. Navigate and select the calls source in the Explorer Tree.  
2. Click Add to Shortcuts from the Explorer toolbar or right-click menu.  
3. The new Shortcut will now appear in the Shortcuts Tree root group.  
4. The name of the call source is applied to the name of the new Shortcut by 

default.  

How to Create Shortcut Groups 

1. From the Shortcuts toolbar or right-click menu, click the New Shortcut 
Group option.  

2. A new Shortcut Group will be created in the Shortcuts Tree root with the 
default name 'New Group'.  

3. The Shortcut Group can be renamed from the Rename option in the Shortcuts toolbar or right-click menu.  

How to Rename Shortcuts and Shortcut Groups 

1. Select the Shortcut or Shortcut Group to rename.  
2. Click the Rename option from the Shortcuts toolbar or right-click menu.  
3. Type the new name of the Shortcut or Shortcut Group.  
4. Press Enter to save.  

How to Organize and Maintain Shortcuts 

Shortcuts can be organized into Shortcut Groups or subgroups, removed, renamed, exported or imported as required.  

How to Create Shortcut Groups 

1. Click the New Shortcut Group option from the Shortcuts toolbar or right-click menu.  
2. A new Shortcut Group will be created in the Shortcuts Tree root with the default name 'New Group'.  
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How to Move Shortcuts and Shortcut Groups into Sub-groups 

1. Select and hold the mouse button down on the Shortcut or Shortcut Group to move.  
2. Drag the item into the target Shortcut Group.  
3. An arrow will appear to the left of the mouse cursor to indicate the drop position.  
4. Release the mouse to move the item.  

How to Rename Shortcuts and Shortcut Groups 

1. Select the Shortcut or Shortcut Group to rename.  
2. Click the Rename option from the Shortcuts toolbar or right-click menu.  
3. Type the new name of the Shortcut or Shortcut Group, press Enter to save.  

How to Remove Shortcuts or Shortcut Groups 

1. Select the Shortcut or Shortcut Group to remove.  
2. To multi-select, hold the shift key down and click on each item.  
3. Click the Remove option from the Shortcuts toolbar, right-click menu or press Delete.  

How to remove all Shortcuts from a Shortcut Group 

1. Select the Shortcut Group to empty.  
2. Click the Clear Shortcuts option from the right-click menu.  
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Step 2 – Create Your Recordings List 

How to Create Recordings Lists from a Shortcut 

1. Select the Shortcut in the Shortcuts tree.  
2. Right-click menu, or double-click the shortcut to bring up the 

Create Recordings List window.  
3. Click Compile to start or Cancel to abort.  

How to Create Recordings Lists from Explorer 

1. Navigate to the call source in the Explorer Tree.  
2. Click the Create Recording List button from the Explorer toolbar or 

double-click the source to bring up the Create Recordings List 
window.  

3. To apply pre-filters, click the Show Advanced Options button in 
the bottom left of the window and set query parameters.  

4. Click Compile to start or Cancel to abort.  

How to Apply Pre-Filters 

Call Source Filters 

1. The call sources set for this can appear in the call source list.  
2. To add an additional call source to the query, click the Add button to launch a folder dialog.  
3. Navigate to the source to add and click OK to confirm.  
4. To remove a call source, select the source in the list and click Remove.  
5. To apply the query and retrieve calls from folders contained in these call sources, check the include sub-

directories option.  
6. Click the Compile button to retrieve calls or Cancel to abort.  

File Name Filters 

1. In the Limit by Filename input box, enter the text which should be 
included in the file name.  

2. Use an asterisk before the text to ignore/include any characters 
before a specific value.  

3. Use an asterisk after the text to ignore/include any characters 
after the specific value.  

4. When using the filter, DO NOT enter the file extension; it is already 
assumed to be at the end of the value.  

5. Click the Compile button to retrieve calls or Cancel to abort.  
6. File Name filters can be used to retrieve only calls by parameters 

on the file name.  
7. File name filters can be used to file the XTR file format file naming 

convention includes the agent who created the call and the 
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date/time the call was created.  
• This filter can be very effective when attempting to specific calls by those parameters.  
• File Name filters use the asterisk character to represent a wild card which can be used several times 

within the input box. By default, the input box value is set to asterisk only which means ANY 
characters in the file name.  

 
 
 
File Name Filtering Example 1: *Davidson  

• Only files which contain 'Davidson' at the end of the file name are retrieved.  
• These would be files like 'Tom Davidson.fileextension' or 'anythingDavidson.fileextension. 

File Name Filtering Example 2: *David* 

• Only files which contain 'David' anywhere in the file name are retrieved.  
• These would be files like 'Tom Davidson.fileextension', 'David Jones.fileextension or 'Paul David.fileextension'. 

How to Apply Date Range Filters 

1. Select from pre-sets by clicking one of the available options; all dates, yesterday and today, Within 7 days, 
Within 30 Days or Specific date range.  

2. To enter a specific date range, enter/select the start date from the after this date input box.  
3. Enter or select the end date from the “Before” this date input box.  
4. Click the Compile button to retrieve calls or Cancel to abort.  

How to Apply File Length Filters. 

1. Click the Only calls larger than option to enable the file length spin control.  
2. Use the Increase and Decrease buttons or enter the minimum value in minutes.  
3. Click the Compile button to retrieve calls or Cancel to abort.  

How to Speed up Recordings List Compilation 

How Compilation Works 
Recordings List compilation is a three step background process requiring no user interaction when started. The steps 
are Indexing, Reading Call Information and Building a Recordings List. 

Step 1: Indexing 

• Indexing is a process which examines each specified call source and builds a list of calls to read which match 
the specified query parameters.  

• During this process, the cursor changes to an hour-glass.  
• The Task In Progress window will appear to show status as 'Scanning'.  
• The Indexing process can be lengthy depending on volume of calls in the call sources.  

Step 2: Reading Call Information 

• Each call in the Index is opened, read to retrieve call information and then and closed.  
• The Task in Progress window will display a progress bar, the number of files found and the number of files read 

during this process.  
• Reading call information is typically the most time consuming process.  
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Step 3: Caching Recordings List 

• Once all the calls are read, a new Recordings List window is created and populated with references to open 
each call and corresponding call information.  

• Typically, the Building Recordings List process is fast and unnoticeable.  

 
 

 

Organizing and Defining Call Sources 

1. Organizing calls into multiple call sources, like department and/or agent, or time periods, provides flexibility, 
precision when querying and can significantly reduce the compilation time.  

2. When defining a calls source, selecting the parent directory of the calls rather than the drive or the parent 
directory of the calls sources will also improve performance.  

Assume you want to retrieve calls from a directory called "Archive Jan 2005" which is a sub-directory of "My Calls" 
stored on your C drive. The path to calls in this directory would be: C:\My Calls\Archive Jan 2005\. The following calls 
source definitions could be set:  

1. Best definition for optimal speed: C:\My Calls\Archive Jan 2005\  
2. Bad definition with slow performance: C:\My Calls\ (with Include sub-directories option checked).  
3. Not recommended definition: C:\ (With Include sub-directories option checked). 

Subdirectory Options 

1. Avoid including subdirectories in your queries when unnecessary.  
2. Un-check the include sub-directories option in the Create Recordings List window. 

Pre-Filter Options 

1. Wherever possible, use Pre-filters to limit the number of calls to read and retrieve.  
2. Apply File Name Pre-filters, Date Range Pre-filters, File Length Pre-filters or all three where applicable.  
3. This will dramatically decrease the time required to access the calls. 

Nothing is happening when attempting to compile? 

1. During the Indexing process, you may experience long periods of what appears to be inactivity.  
2. Also, the Task in Progress window may appear idle with no progress bar, or updated message.  
3. These delays are typically a result of the number of call sources to query volume of calls to index.  
4. The speed at which these operations are processed is dependent on the system processor, memory 

capabilities, other applications running and the available network bandwidth.  
5. The compilation process will display a message in the event of errors.  

 

 

 

 



XTR Reporter Pro 

 
Copyright © Intelligent Recording Ltd 2009     Page 18 

 

 

 

Step 3 – How to Play Calls 

How to Play Calls 

To playback a call, you will need to load it into the Player. The following are methods to load calls into the Player. 

How to Play a Call in a Recordings List 

1. Select the call in a Recordings List and click Play from Recordings List toolbar or right-click menu, or double-
click the call.  

2. The call will be passed to the Player and start to playback.  

How to Play a Call in a Call for Review folder 

1. Select the call in a Call for Review folder and click Play from toolbar or right-click menu, or double-click the 
call.  

2. The call will be passed to the Player and start to playback.  

How to Play a Call from Windows Explorer 

1. Select a call from Windows Explorer and drag into the Player.  
2. The call will load into the Player.  
3. Click Play to playback.  

Playback Controls 

How to Play, Pause, Resume and Stop Playback 

Click on the desired recording in the Play Back List and the call select will be loaded into the Player. You can simply 
‘click’ on the wave form in the player to move from one point in the recorder to another or use options shown below: 

 
 
   

 

 

1. Double-click on a call in a Recordings List will load the call into the Player and start playback automatically.  
2. When a call is playing, the Play button toggles to a Pause button which will halt playback.  
3. When a playback is paused, the Pause button toggles to a Resume button which will continue playback 

from the pause position.  
4. The Stop button will stop playback, pause status and return the trackbar to the beginning of call.  
5. The Play button will start playback from the position of the trackbar.  

  

 

F-FWD 
30 secs 

F-FWD 
10 secs 

Stop 
Play 

Play Rewind 
10 secs 

Rewind 
30 secs 
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Other Controls 

 

 

The Refresh          option will perform a new scan of the folder in view. 
 
 
Select                Search to enable searching for calls in view by User 
ID, Caller ID/Number Dialled , Comment or All. The search will then 
bring into view results from the current view that matches your 
criteria. To return to previous view, select the Refresh option. 
 

Bookmark 

 
A Book-Mark can be added to a Recording at any place. This can be used to highlight an important part of the call 
making it easy to find in the future. To Bookmark a part of the recording simply select Bookmark icon          at the point 
desired and the graphic will display area book-marked in blue as shown below: 
 

 

 
E-Mailing Recordings  

E-Mailing recordings couldn’t be easier. To email as a proprietary and secured formatted recording select the first 
email icon option.             This will attach the recording to an outbound email message; an auto-text         will be 
generated with a link to where the recipient of the email can download a free player. 
 
The other E-Mail option is to select the E-Mail as WAV icon           , this first 
converts the recording to a wav file, then attaches to an outbound e-mail 
message. 
 
Or from the Player Select ‘File’> Send – then choose to either email the 
conversation as a wav file or an xtr file, or if a bookmark exists, you can send 
only the ‘bookmarked’ portion of the recording. 
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Save Files to Other Locations / Convert Direct to WAV Format 

 
It is often desirable to Save and Move important calls from one storage                   location to another. This is done 
quickly and easily by selecting the recording in the Player then clicking on the Save icon.          This XTR option will save 
the recording to another location in the native ‘.xtr’         file format. By selecting the WAV           option, it will convert 
the file to a WAV format and then allow the recording to         be saved in the desired location. 
 

Deleting Recordings 

 
To delete an unwanted call, simply select the call or calls and then press the Delete icon 
 
 

Adding Notes to a Recording 

 
By selecting the Notes icon              , the user can add notes to be stored as part 
of the call record.  
 
Notes can be typed in or selected from predefined notes programmed by the 
user. 
 
Any item in the notes field can then be used later to find the particular call. 
 
 

Customize Pre-Defined Comments 

 
Located in the Program directory, which is loaded in default to C:\Program Files\Comvurgent\XTR Reporter Pro, you 
will find a file called Comments.txt. To edit this file, click on the file and it will display the content as shown below: 

 
 
Simply type in a column any number of comments and how you would like them to 
appear. 
 
Once completed, select File>Save and replace the existing Comments.txt file. 
 
The new list will then appear in your drop-down menus. 
 
This will place the selected text in the comments field; more text can be appended to 
the notes if desired. 
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Important Calls   

 
Calls can be marked as Important by selecting the call and simply clicking on the Important icon.            This will 
highlight the call in the list as well as remove it from any auto-delete routine established in the Options Area. 
 
Many of these functions can also be accessed from the Player Panel as shown on 
the right: 

 

 

 

How to Update Call Information in a Recordings List 

1. When multiple Recordings Lists are open which contain the same call, changes made to call information in 
one Recordings List will not become visible in the other Recordings List until it is refreshed.  

2. Click the Refresh button to the far left of the Recordings List toolbar.  
3. The Recordings List will be re-scanned to omit moved or deleted calls and update call information.  

How to Remove File Locks 

1. The loaded into the Player is locked for exclusive playback and editing.  
2. It will remain locked until it is ejected from the Player.  
3. This may interfere with operations like email, copy or delete if the call in the Player is included in the 

operation; a message will inform you of the problem.  
4. Click the Eject option from the File menu in the Player toolbar to eject the call from the Player and remove 

file lock.  

How to Multi-Select Calls in Recordings Lists 
The following are multi-selection options after the first call is selected: 

• CTRL+A key or SHIFT+A key will select all calls.  
• SHIFT+Mouse-Click will select all calls between the first selected call and the last selected call.  
• CTRL+mouse-click will select/de-select specific calls.  
• The Select All option from the right-click menu will select all calls.  

How to Use Copy, Paste, Trim and Remove 

1. Select the calls to remove or keep in a Recordings List.  
2. Click the Remove option from the right-click menu to remove the selection.  
3. Click the Trim option from the right-click menu to keep the selection and remove all other calls.  
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How to Copy Calls Between Recordings Lists 

1. Select the calls to copy from a Recordings List.  
2. Click the Copy option from right-click menu or CTRL+C from the Keyboard.  
3. Create a new Recordings List or bring the target Recordings List to focus.  
4. Press CTRL+V or the Paste option from the right-click menu if available.  

 

How to Select an Open Recordings List and Bring to View 

1. Click the Window Menu option from the Main Menu.  
2. A list of open Recordings List will appear towards the bottom of the menu by title.  
3. The Recordings List currently on focus will be checked in the Window menu.  
4. Click on the Recordings List to bring to view.  

How to View Multiple Open Recordings Lists Simultaneously 

1. When a Recordings List window is Maximized, Minimize, Restore and Close window controls appear in the 
far right of the Main menu directly under the Main window controls.  

2. These allow you to control each Recordings List like standard application windows.  
3. Click the Restore control to float a Recordings List window and enable resizing.  
4. Each Recordings List window can be controlled independently.  

How to Tile Open Recordings Lists 

1. Window titling options appear in the Window menu from the Main Menu.  
2. Select from Cascade or Tile Horizontal options.  
3. The selection will be applied to all open Recordings Lists.  

How to Append Calls from a Shortcut to an Open Recordings List 

1. Bring the target Recordings List to view and select the Shortcut from the Shortcuts tree to append to the 
recordings List.  

2. Drag the selected Shortcut over the Recordings List and release the mouse button.  
3. Calls in the call source referenced by the Shortcut will be added to the current Recordings List using the 

default Pre-filters.  
4. A progress will be displayed to show the number of calls found and appended to the Recordings Lists.  
5. Recordings Lists automatically ignore duplicate calls.  

How to Append Calls from a Shortcut Group to an Open Recordings List 

1. Bring the target Recordings List to view and select the Shortcut Group from the Shortcuts tree to append to 
the recordings List.  

2. Drag the selected Shortcut Group over the Recordings List and release the mouse button.  
3. Calls in the call sources referenced by all Shortcuts in the Shortcut Group will be added to the current 

Recordings List using the default Pre-filters.  
4. A progress will be displayed to show the number of calls found and appended to the Recordings Lists.  
5. Recordings Lists automatically ignore duplicate calls.  
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How to Append Calls from Explorer to an Open Recordings List 

1. Bring the target Recordings List to view and select the call source from the Explorer tree to append to the 
Recordings List.  

2. Drag the selected call source over the Recordings List and release the mouse button.  
3. Calls in the call source will be added to the current Recordings List using the default Pre-filters.  
4. A progress will be displayed to show the number of calls found and appended to the Recordings Lists.  
5. Recordings Lists automatically ignore duplicate calls.  

 

How to Copy Calls 

How to Copy Calls to Other Directories Using the Explorer Tree 

1. Navigate to the target directory in the Explorer Tree.  
2. Select the calls in the Recordings List to copy to another call source.  
3. Drag the calls to copy into the target directory in the Explorer Tree and release the mouse button.  
4. A confirmation dialog will appear.  
5. Click OK to copy the files or Cancel to abort.  

Note- you can also right click  on a selected recording  and use copy function. 

How to Save and Share Recordings Lists 

How to Save Recordings Lists 

1. Add or remove calls until the Recordings List contains only cal you wish to retrieve.  
2. Enter CTRL+S or click the Save option from Main Menu > File.  
3. Choose the save location and enter a descriptive name in the save dialog.  
4. The file name will appear in the header of the Recordings List when opened.  
5. Click Save to Save or Cancel to abort.  

How to Open a Saved Recordings List 

1. Enter CTRL+O or click the Open option from Main menu > File.  
2. Navigate to and select the .RECLIST file to open.  
3. Click Ok to Open or Cancel to abort.  

About Sharing Recordings Lists 

• Sharing Recordings Lists provides a highly effective and efficient method for collaboration, strategy 
meetings or training exercises.  

• Sharing Recordings Lists is the same procedure as saving, opening and importing Recordings Lists.  
• Saved Recordings Lists contain file path and file name references to the calls.  
• To ensure call information accuracy, only file references are stored in a saved Recordings List.  
• These references are used to access each calls, retrieve calls information and compile a Recordings List.  
• In order to share a Recordings List, users will need to have a common path to calls.  
• Typically calls stored on a server would provide common paths.  

Assume calls stored on a computer in this directory (G:\calls folder\archives\) 
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Sharable 

If this computer is a server or accessed across a network, in the saved Recordings List the file paths would point to 
\\computer name\calls folder\archives.  

• In this case anyone one who can access that path can access the calls referenced by the Recordings List.  

 

Not-Sharable 

• If this computer is your computer, in the saved Recordings List the File paths would point to G:\calls 
folder\archives.  

• In this case, when the user attempts to open this Recordings List, the application would look for these calls in his 
or her G drive.  

• This off course would mean result in files not found.  

Access Play History 

How to Access and Use Play History from the Player 

1. The Player Play History maintains a log of played calls since the application was opened, allowing you to 
toggle back and forth between calls quickly even with the origin Recordings List closed.  

2. Click the Play History button in the Player toolbar.  
3. Select the call to playback from the list and double-click to play.  
4. To remove a call from this log or clear the entire list, right-click and make your selection.  

Recordings List Play History  

• The Play History Recordings List is an application file which maintains a log of all files which have been loaded 
into the Player and played.  

• It maintains a list of up to 100 played recordings and remains persistent after the application is closed.  
• The Play History file is maintained in the background.  
• When Play History is requested, a Recordings List is compiled from the log.  
• The Play History Recordings List by default will appear at start-up when the application loads.  
• You can disable this feature from the Tools menu.  
• To enable or disable, check the toggle option from Main Menu > Tools > Show History on Start-up.  
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Calls for Review 

 

How to Create Calls for Review folders 

1. Click the New Hotlist option from the panel toolbar or right-click menu.  
2. The new Folder will appear with the name 'New Hotlist'.  

How to Rename a Call for Review Folder 

1. Select the Hotlist to rename from the Hotlists Tree.  
2. Click the Rename option from the Hotlists toolbar or right-click menu.  
3. Type the new name of the Folder, press Enter to save 

 

How to Add Calls to a Call for Review Folder from a Recordings Lists using the Hotlists Control 

1. Select the calls in the Recordings List to add to a Folder.  
2. Click the Calls for Review button in the Recordings List toolbar.  
3. The Folder tree will appear inside the Calls for Review Control.  
4. Navigate to the Folder where the selected calls will be linked and double-click to add.  
5. The added calls will appear in the Folder tree.  

How to Add Calls to a Call for Review Folder from a Recordings Lists using Drag & Drop 

1. Select the calls in the Recordings List to add to a Folder.  
2. Drag the selected calls over the target Folder and release the mouse button.  
3. The added calls will appear in the Folder tree.  

How to Add Calls to a Call for Review Folder from a Recordings Lists using Copy/Paste 

1. Select the calls in the Recordings List to add to a Folder.  
2. Enter CTRL+C or click on the Copy option from the right-click menu.  
3. Select the target Folder and enter CTRL+V or click the Paste option from the right-click menu.  
4. The selected calls will be added to the target Folder.  

How to Add a call in the Player to a Review Folder 

1. Click the My Calls for Review button in the Player toolbar.  
2. The Folder tree will appear.  
3. Navigate to the Folder where the call in the Player will be linked and double-click to add.  
4. The call will appear in the Folder tree.  
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Get Expert Help. 

We invite you to visit our web site for support: http://www.usbcallrecord.com   

- Technical support and assistance when setting up your   XTR Reporter Pro  
- The latest software and firmware downloads for your   XTR Reporter Pro including feature enhancements 

and bug fixes 
- Advice about   XTR Reporter Pro 

We greatly appreciate your business and thank you for choosing the   XTR Reporter Pro by Intelligent Recording Limited, 
Inc. 

 
 
 
                                      
 
 
 
 
 


